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Overview of Visualize 3D CATIA V5 to JT Composites Add-on
Module

The CATIA V5 Composites Engineering application is used to create detailed component
definitions for parts that are manufactured from composite materials. These component
definitions comprise of a combination of 3D geometry and additional composite
manufacturing parameters.

The Visualize 3D CATIA V5 — JT Composites Add-on license module (product code CA5JT-A8)
enhances the base CATIA V5 to JT translator to output the composite geometry and
manufacturing parameters for review within the JT visualization application.

Primary Product Features

e Converts all CATIA V5 Composite Engineering geometry and manufacturing
parameters

e Integrated with the CATIA V5 installation.

e The conversion process can be run Interactively, Batch Mode or using the new
Unified Interface

e Command line interface allows process integration into any workflow or automated
process.

e Created using the Dassault Systems CATIA V5 CAA and Siemens JT Open API’s to read
and write the respective data formats.

e The JT output data is fully configurable using standard JT Configuration file settings

Primary Product benefits?

e Being a direct database converter all pre and post processing is eliminated, saving
time.

e Reduce costs due to processing time and increase overall conversion success levels
by filtering input data and focusing the conversion to only those elements required.

e Reduce costs and risks associated to accessing the wrong version of data by
integrating the conversion process into a related business processes.

e With over 25 years of industrial use Theorem translation products robustness and
quality is well proven, reducing your business risk.
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Getting Started

Documentation
A copy of the latest documentation for all Theorem Solutions products can be found on our
web site at:

http://www.theorem.com/Documentation

For each of the Visualize 3D related products there is a specific link that provides user
documentation in the form of PDF and Tutorials. For this product navigate to the Visualize
3D CATIA V5 — T section.

Software Installation and License Requirements

The Theorem software installation and license configuration processes are fully defined in
separate documents. Please refer to the documentation and on-line videos from the
documentation website for complete installation instructions of the Theorem components.

The Composite Add-on module is also integrated with CATIA V5. Therefore, not only is a
Theorem CATIA V5 — JT Composites Add-on module license required but also a CATIA V5
Composite Engineering license also needs to be available when reading the Composites data.

Software Configuration

With the CATIA V5 —JT software and license installed the final step in the configuration
process is to enable the features of the Composite Add-on module. This is achieved by
running the MDB Extensions script in the installation folder. This script should be run by a
user with Administrator access rights.

The script is named %TS_INST%\bin\install_v5rXX_mbd_extension.cmd replacing the
characters XX with the version number related to the CATIA V5 release required. E.g. for
CATIA V5-6R2016 (V5R26) replace the characters XX with 26

i.e. %TS_INST%\bin\install_v5r26_mbd_extension.cmd

Starting the CATIA V5 to JT Process

Once configured and licensed, the product will be ready to be used.

Prior to initially using the translator CATIA V5 must have been launched at least once to
allow the selection of the CATIA V5 licenses to be recorded in the users CATSettings folder.
Once the CATSettings are generated the translator will be able to be executed either
internally or externally to CATIA V5 until the CATSettings are removed. Therefore if you
operate a procedure that programmatically generates the users CATSettings this
requirement to maintain a reference to existing CATSettings must be considered when using
the product in batch mode external to the CATIA V5 application.

Methods of Invoking the Translator

The Visualize 3D CATIA V5 to JT translator can be invoked in a variety of methods,
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these include;
e Interactively from within CATIA V5 using standard CATIA V5 menu options
File>Theorem Export
e From the Theorem Graphical User Interface (GUI)
e From a command prompt window using the command line. This mechanism
can be used to automate the translation process as part of any automated
workflow.

Setting the Composites output option

The default CATIA V5 to JT translator will ignore the exporting of CATIA V5 Composite
parameters resulting in the JT file simply containing the CATIA V5 composite geometry.
However, to invoke the processing of Composite data it is necessary to add the command
read_composites to the translation process. This can be achieved by a variety of different
methods that are all depend upon the users’ preference for running the translator.

Using the Command Line Option

When running the translator from the command line simply add the optional argument
read_composites to the end of the options to process the composites data. Therefore, using
the standard command line interface %TS_INST%\bin\cad_run_Ul.cmd

e.g. ..\cad_run_Ul.cmd CATIA526_JT -i <catia_filename> -o <jt_filename> read_composites

When using the command line mechanism, the translation process can be integrated into
any automated workflow. Such as an automated process linked to a data management
process whereby all CATIA V5 data is processed during the life cycle updates of components.
Therefore, ensuring that all data is processed consistently without having to ensure users
perform the update manually.

Using JT Configuration Files

The JT Configuration file is used to control various options related to either the reading of
the CATIA V5 data or the writing of the JT output. As such it can manage which elements
from the CATIA V5 data need to be processed as well as controlling the specific nature of the
JT data that is written as well as the format it is written in.

To ensure that CATIA V5 Composite data is automatically processed you can add the
read_composites option as a Configuration file AdvancedOptions setting. This edit can
either be added to the default CATIA V5 to JT configuration file which is stored in the
software installation, %TS_INST5\etc\tessCATIA5.config. Alternatively, add the setting to a
new configuration file and use it only when processing CATIA V5 Composite models.
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Using a JT Configuration file can ensure that casual users use the correct translator options
without having to ensure they use the options correctly. This can aid with ensuring the JT
output is created consistently by all users.

Using CATIA V5 to JT CADverter Configuration Options

The CADverter User Interface allows the user to define specific translator Configurations.
These Configurations retain the user selected options and can then be used to control a
translation process when it is invoked from either the command line, from within the CATIA
V5 Theorem Export menu or the CADverter User Interface itself.

To add the read_composites option to a CATIA V5 to JT CADverter Configuration simply
select the General tab from the Configuration Manager page of the required CATIA V5 to JT
translator and add read_composites to the Advanced options dialog.

E“ﬂ Configuration Manager ~

| ﬂ File Browser - #% Translator Batch ~

W5R26-JT_Composites

Translator: | CATIA V5R26 -> JT + D X [O %= & My o
Configuration Description: |Process CATIA V5 Composite Data
<default>

CATIA W5 Read | JT Write | Entity Mask = General

Option Name

Mass Properties

Value

L]

Advanced

read_composites

Then process the input CATIA V5 data using the selected CADverter Configuration to invoke
the composite processing during the translation.

Interactive usage within CATIA V5

Starting CATIA V5

To use the CATIA V5 to JT translator interactively from within the CATIA application, you must
start CATIA V5 with the correct CATEnv environment settings.

A default CATEnv file is created in the standard CATIA V5 CATEnv file with the name
TheoremCatia5Rxx.txt — replace the characters xx with the reference number for the specific
CATIA V5 release that is being used e.g. for CATIA V5-6R2016 (V5R26) the filename is
TheoremCatia5R26.txt.

There is also a CATIA V5 start-up script provided in the software installation folder. The script
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is named catia5rxx_start.cmd and starts the CATIA V5 application referencing the
appropriate CATEnv file. Replace the characters xx with the reference number for the specific
CATIA V5 release that is being used e.g. for CATIA V5-6R2016 (V5R26) the filename is
catia5r26_start.cmd

Alternatively, to add the paths to the Theorem installation into another CATEnv file refer to
the Dassault documentation for using the standard CATIA V5 command setcatenv.exe which
will merge the Theorem settings with CATIA and other third-party applications into a unique
CATenv file of your choice.

Using the “Theorem Export” menu

The CATIA V5 to JT translator can be invoked from within the CATIA V5 menus by using the
File>Theorem Export menu selection.

Y CATIA V5 - [ButtSplice_NoSplice-02_End.CATRart] - o *
B sor [ st Wiew  Inset  Tooks  Window  Help

o R o
Cul+0
Ctrl+5 Th
Solutions
Export | Configure |
Export type
Clil+P n o
Input CATIA VS File Name %
_C:\Uuri'\llww'\gu:umlr\b\dlrrw_le(ll\CltllVﬁ‘.CErf;l
B S Sanitize
Qutput File Name - S
5 _C:'\Uqen'\lu-\.-n(‘.Dncument;\dem_local‘.CanS‘\CorE_:J
; Progress File Neme :
g.l Document Propesties C'\Uscrs‘._lln'ut".Ducumcr|ls'\dcm_local‘\fniaVE\Cur;‘:J
|| 7
1 ButtSplice_NoSplice-02_End.CATPart
LE
2 PlyBook-02_End.CATPant i
3 Panel-05_Step3.CATPart i |
4 IML-from-plies-02_End.CATPart ‘I
|

5 Fuselage-02_End.CATPart
g Theorem import

@ Theogem Export
Exit

Ny mw—mr—r—ws B8 wTenAALBG06EE 3 248 2,

Invokes Theerem Solutions Export process |

Using the Export tab of the Theorem Export menu allows the user to export the active CATIA
data writing the output to the JT file format. By default, the output file will be written to the
same folder that the original CATIA data was opened from. The resultant JT filename will
mimic the name of the CATIA input data with the file extension being set to “.jt”. However,
the user can override this selection and direct the output to be written to a folder of their
choice using an alternate filename for both the JT file and the translator progress file which
contains a complete audit trail of the translation process.
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The Configuration tab allows the user to select a pre-defined CADverter User Interface
Configuration to be used during the translation.

B CATIA VS - [ButtSplice_MaSplice-02_End CATPart] - m] 4
B stat e Edit  View nset  Jook  Window  Help

N
®

Theorem Fxport

Theorem

Solutions

Export | Configure I
Configuration

RRABCISE® Bl @l,

Configuration Description
Process CATIA V5 Composite Data

L) ox|¢ma|

it

NEHdS .. @9 R 6@ B8 T4, 009066 3 S48 2,.

|idm Input File Name |

The predefined CADverter User Interface Configurations are automatically available when
using the Theorem Export CATIA V5 menu option.

Working with the JT Output

The JT files are written using the JT SUBNODE property construct. This allows the CATIA V5
Specification Tree for the Composite model to be navigated by the JT user. It also allows the
JT user to navigate the various sub-elements of the overall CATIA V5 model and query the
appropriate CATIA V5 Composite manufacturing properties.

When using the Siemens Teamcenter visualization application (VisMockup) to open the JT
file the initial view shows the complete model in the assembly tree. With the mouse pointer
positioned in the Assembly Tree window use the right mouse button and select the option
Show Leaf Structure. You will then be able to navigate around the sub-elements of the
overall component in a similar manner to navigating the data in CATIA using the
Specification Tree. For a selected element of the tree you can also review the associated
properties which have been output as part of the translation process
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Teamcenter Visualization Mackup 11.3 - [Composite_Demo jt]

View Render Analysis Review Assembly Animation Manufacturing Tools Immersive Quality Jack Help
o%?. |§§' =N —y & o; op % 0 AT M * 3 &‘ B & e
> 2 B > /0D 0 BY% B @ .
Enable Visual  Apply Visual Report | Enable 3D New Select » Auto g H g = Remove Markup Image Snapshots| Presenter Groups,
Report Report & Preferences | Markup  Layers 4 create @ @ B & Al Preferences Capture - - -
Visual Report Markup Image Capture o]
K >
=Mew | 2 Wy e gl . Bld o o+  Sw A E et
Project Workspace Properties
5 ftem Name  Atributes Geometry Extent
| =o@Models
é“{SECDmpusite,Demm Attribute Value
&5 & Part2 0 0Odeg
- ¥ Reference surface CAD_MASS_UNITS kilograms
£ 73 ¥ Splicing curves CAD_SOURCE: CATIAS
|- ¥'Butt Splice Zone Cured Thickness 0.1mm
9 No Splice Zone Density: 1250kg_m3
=7 [ Stacking Fabric Width 1200mm
1575 [ Plies Group.1 Limit Deformation: 30deg
= = [¥Sequence.1 Glass 0.1
EETcgr Material Type Bi-directional
QDECumpusites Geometry.1 Maximum Deformation:  15deg
“J ' Cut Piece Group.1 Rossette Origin 302.07.-601212,0
= T Cut Pieced Rossette XAxis 1.0.0
L % ' Composites Geometry.8 Rossette YAxis: 0.1.0
I Cut Piece.3 Translation dateftime:  Tue Apr 10 14:23:20 2018
U Cut Piece.2 Translator Config CA\Theorem\21.1_vbjfiletc\tessCATI
I Cut Piece.1 Translator Title: catiabr26_jtexe
7 W Sequence.2 Translator Toolkit JT Open JTTK Version 9.0.0.0 (Build:
+#+ 7 [ Sequence.3 Translator Version: Theorem Seolutions CADverter Versi.
=) ¥ Construction Geometries Uncured Thickness 0.12mm
#+ 7 [ Composites Parameters Weight per Surface unit 0.25kg_m2
AddAsColomn || Find.. | Pint | | ExporToFile |

|

| For Help, press F1

This picture shows the CATIA V5 data having been processed to JT. The composite
manufacturing properties for one of the plies is being reviewed.
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